Using Effects in BEYOND
How to use the Effect editor in BEYOND

BEYOND Version 2.0, build 620 and higher

The information transmitted by this document is the proprietary and confidential property of Pangolin Laser Systems, Inc.,

and may not be duplicated, disclosed, or utilized without written consent from Pangolin Laser Systems, Inc.



INTRODUCTION

Most laser content images are static (unmoving) unless
they are part of a multi-frame animation (multiple
frames in sequence to give the appearance of
movement). The main way you would make a static
frame into a single frame animation is to apply an effect
to the laser content. This document will explain the use
of the Effect Editor to accomplish this.

The Effect Editor in BEYOND is found on the right side

of the BEYOND interface, under the preview window,
and within other editors where it is required.

¥ Channels B3] PangoScript Master
H? Live Control @ Time Control = Effect
Since the Effect Editor is a shared resource, the Title Cue " Pangolin" &
inside Effect tab tells you what the Effect Editor is
currently working on. = Add - E & &

The Effect Editor “E” icon can also be
see in cues.

Favorite Effects

To add a new effect, just click on Add button.

Alternatively, you can double click on one of the
Favorite Effects from the library under Effect >
Editor. (
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At the right side of the effect Title,
there is the “Effect Properties” button
that will open a corresponding dialog
box for additional effect properties.

Effect properties

w |nformation

w Name
Effect name
i frame Cube and Coordin:

Identifier 4P

The object |

0.000
W, BPM shift ~
Enable b

v FI[I_IiF‘ [il‘ln 2one l:l'-."EfllidEf
I

y Normal [do not overide)

Time 1.000

-

w Effect duration limiter
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Oscillating effect

Oscillating effects are made for
continuous motion between definable
Start and Finish positions. The duration of
the effect motion can be set in Time
(seconds) or in Beats. The Clock icons
means Time based; the Metronome icon
means Beat based. The Start, Finish and
duration (Beats/Time) are the main
adjustable parameters for oscillating

effects. All oscillating effects use this logic.

Input - instead of time based oscillating
motion, BEYOND allows the use of
external data, such as MIDI, DMX, Kinect,
Audio analyzer, or Channels to control
aspects of an effect. Effect positioning
between the defined Start and Finish
values will depend on the value of the
inputed data. For example, a MIDI
controller has values in the range of 0 and
127. When a value from the controller is
0, the Effect will be in Start position;
when the value is 64, the Effect will be in
the middle and when the value is 127, the
Effect will be in the Finish position. The
same logic works for all input types.
BEYOND receives the range of input
values, normalizes the input values, then
calculates the Effect.

Delay is a phase control adjustment that
is measured in percent.

Start =

Fihi:i-:h v

w Mot active

Input setup

hannel
Audio in frequency [FFT)
Audio in frequency (FFT unfiltered)
D put 1
D put 2
DM Input 3

DMX Input 4

Gamepad

10

100

1.00 =

v

Cancel
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The Options button offers a variety of wave forms to define the
acceleration of the effect, or how the value will go from Start to
Finish; the default option is a linear waveform. There are a variety
of options such as Accelerate, Decelerate, Ping-Pong, Discrete
steps, Random, and Finally - Custom Wave form. Custom Wave is a
waveform that you draw or paint yourself. In ST2000 the

parameter has the name “Rate of Change”.

Still State will inject a static state into the
waveform. Default state is 1, which means
that the waveform is not modified. A value
of 2 means that one part of the waveform
is original and the second part is a static
state. A good way to visualize this is in the
Timeline editor where it paints the waves
for Oscillating effects.

Damping decreases the amplitude of an
effect as it runs. BYEOND uses an

exponential ratio for this calculation. A

value of 0 means no damping at all. A

bigger value means that the effect will start to
oscillate slower.

Ping-Pong {normal)

Ping-Pong {smooth)
Linear

Accelerate

Bounce

2 discrete steps

4 discrete steps

8 discrete steps
16 discrete steps
Linear (once)
Custom Waveform
Random

More

Options Ping-Pong [hormal)

1sed to control an effect, the

| '.v'-.'}'lE'.r'l thEt c:harn'n:l '-.ralue i:i:
vill be applied when then
channel value iz 100
Still state ~ 1.00

0.00

Damping ~

Action...
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Action is an advanced Effect Property.

See corresponding Chapter. Effect item properties

w Front ac
Enable Front action
Event

Duration

w Enable/Disabl quence

y Effect always enabled

On/0ff by
O
Al 'l:' oo

i even

Default state gy On

Beat based On/0Off sequence
On/0ff sequence by one Event

Eveni

In Timeline mode Oscillating Effect has
options Stretch mode and Repeat mode.
Stretch means that effect duration depend p Timeline/Stretch mode
on Event duration, Effect fit into the Event
Repeat mode mean that effect period
depends on time only, same as it plays in the Cue or other place.

Cl Beat mode
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Key effect

A ‘Key effect” is an effect based on a sequence of
key states. There may be one or more states and an
interpolation in between. There is a simple timeline, [k 1.00 - "‘
and each key state can be placed at any position (by
time).

Time/Input i Effect bas

Time/Input - define how Effect should work,

depending on Time/Beat or on Input. See chapter * Create key

with oscillating effect that discuss Input, or Input _»
dialog. X 400 =
Period - defines the duration of the key effect in 00 =

Seconds or Beats. 00

Timeline - Double click on the simple timeline to | it side: 0%
create a Key. The Context menu of a Key offers a
couple of simple operations like Delete, Lock, and a
list of Wave forms (rate of change). Each Key has its
own setting. BEYOND offers a few standard wave
forms, same as Custom Wave Form. This section is
the same as in an Oscillating Effect. The context
menu with wave forms is also available in main Timeline (timeline mode).

Action...

Enable auto keying - will create a key, in current time position, if you change the effect parameter. In
other words, if you put the timeline cursor into desired position, and move the effect parameter slider,
BEYOND will create a key automatically where your cursor was on the simple timeline.

Create Key - create a key in simple timeline at the current cursor position

Delete - Delete selected Key.

Effect parameters panel depends on the effect type. There is one typical parameter - Action. Action is
sort of a morph between the frame before and after the effect is applied. It will define how much the
effect is applied. Each effect has a different implementation of this action; sometimes BEYOND will
morph the effect parameters, sometimes BEYOND will morph the frames.
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Presets - For each key effect there is list of presets. A Preset is a simple container for effect values where
you can save your frequently used states. Right now this is just a constant. In addition to Add and
Delete buttons there is a Context menu that has commands such as Update, Rename, Add and Delete

Action is an advanced Effect Property. See corresponding Chapter.
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The Key effect time
resolution is controllable
when working in BEYOND
Timeline mode. If you click
on the Effect linein a
Timeline show, the bottom
of the context menu will
show:

High Resolution Mode -
resolution of effects same as
for Events, more than
1/1000 of second.

Quick Resolution Mode -
“present”, 100 time
divisions.

And menu Set Resolution
with options - 16, 32, 100,
Other... you can set the
resolution to what you
want. Low resolution has
the advantage of making it
faster to set a key into the
right position. It works fast
and with no mistakes. High
resolution is important in
timeline shows, but it takes

Add Effect Item...
Copy whole Effect
Copy Effect Item

Delete Effect Item

Disable
Duplicate Effect Item
High Resolution mode

Quick Resolution mode

Set Quick Resolution

more time to place the key effect into an exact position.

16

b P

64

100

Other...

Increase resolution 2 times

Increase resolution 10 times
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Color Effect, Brightness Effect, Power Effect

BEYOND has a group of 3 effects controlled from one Effects menu. The Color Effect changes (replaces)
the RGB values, the Brightness effect modifies the RGB values used in controlling the level of specific
dolor channels, and the Power Effect injects additional Anchor points to increase the power (brightness)
in laser content. The Power effect can inject up to 10 anchor points into each point where it is used.

Gradient/Color line

The Color effect is similar to a key effect.
There is a sequence of color-keys that
compose a gradient or a sequence of
colors. Double-click within the color area
to create a new color-key. The Gradient
area also has a context menu. The top bar
of the gradient line allows you to choose
the color of the color keys and are for
changing the position of the keys.

olor Control, Gradient

The Color line creates a color pattern that can be applied to the laser content in several different ways
specified within the Options button.

The Options button gives access to a menu for

defining how to apply the color effect to the laser
content.

i Points

By points - depending on the linear order of points
within the frame. First point is the start of the pattern;
last point is the end of the pattern.

iy Radius

By X axis - based on the X coordinate of the portion of

] i Time
the laser content (horizontally)

By Y axis - based on the Y coordinate of the portion of
the laser content (vertically)

By Z axis - based on the Z coordinate of the portion of the laser content (backward-forward)
By Radius - based on the distance from center of the laser projection area

By Time - uses the pattern as a sequence of colors, where one color will be applied to a the whole
frame.
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Color effects have a few modes; the basic modes are available from Add menu, but a few are specific,
and they are “hidden” in Options menu.

Color control - effect completely replaces the original Color Control
color of incoming frame. e
Hue+Saturation (replace color)
Hue+Saturation - (replace color) - effect keeps the
brightness level and changes only the Hue and

Saturation Brightness Control

Hue shift (experimental)

Hue Shift - effect uses the Hue component of the color Power Control
pattern and adds it (shift) to the Hue of incoming Gradient
frame points. A Hue effect creates a circle where red is SrasiEnt
in the beginning and has value 0. If the incoming Discrete
pattern has a value of “red”, then the effect will not

cause a visual change in the output.

Brightness control - controls the brightness only.
Power Control - inserts anchor points to increase the brightness of the content.
Gradient - color pattern change uses a gradient (smooth change between key-colors)

Discrete - color patterns is a sequence of
fixed colors, no gradient in between

Repeats - define how many times to apply
the color pattern to the laser content.

Speed~ 1100.00=

v

Speed - scrolling speed of the color
pattern

Time Shift 0.0
Time shift - phase control. = =
Alpha Blend - defines a mix between the 100.0
original frame color and the effect color. ‘

Alpha Blend » ALLR N B

Action Start - defines a start area, from
where the effect can be applied. Before Action Start [
the start, the effect has no action

Artion En 100.0 ~
Action End - defines an ending area, from Action End
where the effect can be applied. After the

end, the effect has no action ass 0.0

Bypass - protects a part of an incoming
frame from the effect. This parameter

works well with Time Shift (phase control). For example, you can apply a color effect first to a half of
frame (bypass = 50), and apply a second effect to the second half of frame (bypass=50%, shift = 50%).
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Speed Options button is just like the
Options button in an Oscillating Effect Speed option: Linear [continuous)
and offers a variety of wave forms to :
define the acceleration of the effect, or Action...
how the value will go from Start to
Finish; the default option is a linear
waveform. There are a variety of options
such as Accelerate, Decelerate, Ping-
Pong, Discrete steps, Random, and Custom Wave form. Custom Wave is a waveform that you draw or
paint yourself. In ST2000 the parameter has the name “Rate of Change”.

ul[:l}lfi Blend m Mot achve

Action is an advanced Effect Property. Effect item properties
See corresponding Chapter. w Front action

Enable Front action
Event
Duration
Allow restart while active
w Enable/Dizable sequence
y Effect always enabled
On/0ff by separate Events
O
VO eveni

Default state gy On

Beat based On/0ff sequence

On/0ff sequence by one Event

N s b
e
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Alpha Blend - alpha blend is
designed to be used with and
external Effect Input. “Input”
can be used in variety of places
and will allow for external
control of effect actions. For
more information on this please
check the Input
documentation.

Input setup

BEYOND Channel

Audio in frequency (FFT)

Audio in frequency [FFT unfiltered)
DX Input 1
DM Input 2

% Input 3

* Input 4
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Filter effect Jensity Filter

Density Filter - Enable Visible Line density. Enable
this filter to ensure the density of lines with visible
points is not less than the specified value in
“Density”. Some effects create a distortion of point [T
distance; on occasion such distance can be too big
and problematic for output. This filter can transform
Vectors to Points, which can be important for Color
effects, or surface mapping effects.

Density

X Remove long blanking path (and mark

X Remove anchors [and mark a ctor)
w Soft line ending

X Enable t ending" filter
Optimization Begining

Remove long blanking path - removes sequential Ending
blanking points and replaces them with only one

blanking vector. Dep

w Drop shadow

Remove anchors - removes all anchor points and
marks the points as vectors. Vectors are optimized X Enable "drop shadow" filter
at the end of the calculation path.

Angle
Both of these options are a sort of dynamic re-
optimization of the laser content. If you replace the
blanking path by a vector, and also change the
anchor points to “vectors”, then this creates a “semi vector” frame from any laser content. The visible
points stay as they were when the content was created; all blanking and start/end anchors are under
control of the optimization system within BEYOND

Depth

Soft line ending

Beginning and Ending define a number of points of visible polyline endings that will be modified by an
effect.

Depth defines a level of to decrease the brightness of a line.

Drop Shadow

Creates a 3D light effect.

Enable “Drop shadow” effect to turn on this effect.
Angle - angle of the light

Depth - amount of effect.
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Zone Chase Effect
Zone chase

Chase property  Effect

Clock
Metronome
y Event FFT 10

Manual [Object/PangoScript)

nosp heric

Cancel

The Zone chase effect works with the zone/routing information of the laser content. As a rule, effects
operate with the RGB values or XYZ coordinates of points of the laser content. Each frame has two
additional parameters - scanrate and routing. A Zone chase effect redefines the routing information for
an animation. Within the Zone Chase settings menu, the number of steps in the chase and the number
of zones used in the effect are editable.

The Zone effect options include:

Add row - add a row into chase; each row represents a route to one or more projection zones.
Delete row - deletes current row

Edit row - edits the row destination route

Add Step - adds a step to the chase

Delete Step - deletes a step from the chase

On, Off, Toggle - the row grid allows you to select multiple cells (by using the Shift key). Once multiple
cells are selected you can click the On, Off or Toggle button to change all the selected cells.

Chase property

Clock - the chase speed is defined by Time (seconds). Value is the duration of one step.

Metronome - the chase speed is defined by Metronome (beats). Value is the duration of one step.
Event - In the drop down selector you can pick one of standard names listed or enter your Own Event
name. Entering your Own Event name is used for using PangoScript.

Manual - this is for using PangoScript to control the chase property. The step index will be controlled by
PangoScript
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Effects in Chase.

Chase effects are essentially an Effect within
an Effect. For example, we can define how
laser content will appear in a zone, and how Start effect End effect
it will disappear. This is implemented simply
by defining some period of time in beginning
of the step for BEYOND to apply a start ot 4dd —
effect during and then another effect before

the end of the step. / Dscillating effect - Zoom [10%...100%] Linear A

q,/ Color effect, By Points, Color Control, Gradient l

Chase property Effect

0.200

Duration 0.200 — : Duration

Start Effect and corresponding Duration
control the starting effect

End Effect and corresponding Duration
control the ending effect.

Start »

Finish =

Input Mot active
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Zone routing (Zone math)

Only a Man who read the Manual deserves to know a secret, why FX in BEYOND has 6 lines instead of 4.
The answer is Effect based routing. People who do not read Manual will set the routing in the Cue, or do
endless clicks in NxN Preview window. That is not bad, but there is “plan B”.

Effects can change the projection zone routing of laser content. When you play the Cue from the
workspace grid you can change the routing by means of an effect. You cannot do this by means of NxN
Preview window... AND the Cue Properties in realtime. The answer is to make an Effect. In BEYOND,
extra FX lines have been added for routing control.

Set Zone - removes routing information of
incoming laser content and redefines the routing
based on its own settings. This is simple
redirection.

Add Zone - adds a zone to the incoming laser
content.

Delete Zone - deletes zone routing (if it exists)
from incoming laser content

Replace Zone - replaces the routing information.

These four operations are real routing math that allows you to manipulate the laser content with routing
information. The question is - WHEN? to do this..

You can do this at the ProTrack, Cue, or Master Level. Also at the Zone Level. When the laser content
comes to the projection zone level, it too can change the routing information. All laser content that is
routed into the Zone will stay there.

The most attractive place is within a ProTrack. Each ProTrack has its own Presets and special Zone
properties to access from PangoScript. The Zone math is an additional method to control ProTracks.

Palette effect

The Palette effect is a simple replacement table of one color to the
other. All that is required is for you to define a pair of colors - Original
and New.

Original color Mew color

The effect works with exact colors. No “delta”, no animation. There is
a similar Key Effect, “Replace Color”, if you need more control.
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Effect Properties

Effect name - name of the effect as it will IEAiENE
appear within the user interface; for Tl e Panning effect #1
example, in the FX Grid.

Preview frame Cube and Coordinates

Preview frame - for effect visualization,
BEYOND should use a Preview frame. Identifier 4P MyPanEff
BEYOND offers four standard Preview ject identifi
frames. One of them came from

QuickShow, this is default option, three
other frames are from LivePRO, and are
used for Effects, Key Effects and Color Cycle.

Identifier - identifier is used for access to the Effect as a 1st level (public) object. This is helpful when
working with external access by OSC, using in the BEYOND Universe, or for PangoScripting. When an
Effect has an identifier, it can be addressed from any place.

Multi Zone time shift - For applying such operation we need a few things:
o Laser Content should be routed to multiple zones

e Delta (time shift) between zones

o Action - Effect

BEYOND takes the incoming frame, calculates the effect for the 1st zone, saves the result, takes the
original frame, applies the effect with time shift, saves for the second zone, takes the original frame,
calculates the effect with double the shift value, saves to third zone and so on... [¥]. The important
consequence - at the time the laser content is incoming, we have one frame that is routed to multiple
zones, and once outputted - multiple frames being routed to one (corresponding) zone.

Please note, Multi zone time shift can only be applied once, and instead of one frame we have many
frames at the output point as it is too late to do at the Projection Zone level.

Clock Shift and BPM shift define a

“delta” - time shift between zones. € Clock shit
LIOCK Shilf »

Note that the parameters can be

0000 =

v

controlled by Input options. W\, EPM shift ~ 0.000 =

Time shift is a property of a whole Enable Master effect shift for this effect
Effect. BEYOND will calculate the
effects before it applies them to the laser content.

Enable Master effect shift for this effect - Master tab has two sliders specially dedicated to be used with
Master value, a value applied to all effects. Such things cannot be applied to all effects. When you
enable this option, you allow effects to be used with a time shift.
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Projection Zone override.

This option in the Effect properties is calculated before the creation of a Zone Chase and Zone Routing
effect. This can be considered a duplicated option but, this option works great with Multi zone time shift
effects.

Actions are:

ion zohe override
Normal - leaves routing information as 0
itis MNormal [do not override

Flash - toggles between the original

i i 1 y F:E‘-p]-it:e (1
routing information of the laser )

Chase [use Effect zones one after another|

content and the routing defined in the
effect Time

Replace - assigns the routing defined in
effect instead of original defined
routing.

Chase - uses Projection Zone list as the
chase definition. This is a simple chase,
by one element only.

Time - duration of the step for Flash
and Chase modes

Effect Zones

Routing information (Projection Zone names) for Flash, Replace and Chase.

Effect duration limiter.

Options Limit clock duration and Limit
beam duration suspend the time after
the specified limit. The incoming time Limit "clock™ duration
will pass as it did before the limit, but
after the limit the higher values will be
limited to the value defined.

w Effect duration limiter

Limit "beat" duration
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FX Cell Property

The FX Cell property is an option added
specifically for the FX Grid. This is not a
full-blown system of clicks, limiter, and
other tricks as it is made for Cues, but
this is to help organize the FX grid
better.

ell property
Mode
y Default
One

Pulti

D rop

Default - use current click mode
defined by FX tab toolbar buttons

One - always on “one” effect mode. Such effects work “all alone” in the FX line
Multi - always in “multi” effect mode. Such effects are designed to be combined

Drop - always in “drop” mode.
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Effect Item properties

The Effect Item properties are a setting for one single effect item (operation). Each item has its own
settings. This effect is designed to react on Events such as audio changes and for simple on/off chases.

Front Action

This is an exceptional option! As a rule, w Front action
an effect uses the time of the cue player,
of live control, or of a timeline... but

X Enable Front action

Event Audio

never its own time. Time comes as
argument and the effect acts as a Duration
function. When you enable this option,
the effect will use ITS OWN TIME, and Allows restart while active
ignore everything else.

It is designed to react to audio peaks. For example, if you want to create an effect like “jump up” as a
reaction to a bass drum. To make this happen, we need a few things set up for us:

Event - this effect should react within an Event. Here you define the name of the event. It can be a
standard event name or a custom name that can be used in PangoScript by means of PulseEvent.

Effect - the effect you want to use.
Duration - length of reaction. The effect will react and then stop based on this duration value.
Enable front action - mark this to enable this feature.

Allow restart while active - defines what to do if the event repeats, while this effect is active. If you
choose restart, then it will interrupt the execution and start from beginning.
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Enabled/Disable sequence

This group of options allows you to w Enable/Disable sequence
enable or disable an effect based on a
few options.

Effect always enabled

On/0ff by separate Events

Effect always enabled - this is the default
state; the effect will always work. "0 "Evend

On/Off by separate Events - the first "ORF" everd

Event enables the effect item, the second [REEEEEEELE » On
Event disables it. For example, a bass
drum to enable the effect, and a snare
drum to disable the effect. The Effect can ) On/0ff sequence by one Event
work in between the two events.
Actually, the caption is not 100% correct.
You can use the same Event for On and
Off. It will also work correctly.

Beat based On/0ff sequence

Audio

“On” Event - the Event name that will
enable the effect item.

“Off” Event - the Event name that will
disable the effect item.

Default state - the initial state of the effect item - enabled or disabled.

Beat based On/Off sequence - this is a Metronome (beat) based sequence, like a chase. This option
allow a chase type effect. For example, the first Effect item will be active at the first step, and second
effect item will be active on second step. Such interaction allows the ability to organize more complex
effects where some items will work, the other items will be disabled.

On/Off sequence by Event - A chase driven by the Event. Each Event increases the step index by one.
Number of steps - number of steps in the sequence.

Sequence checkbox list - a list of steps, a checked state means On (enabled).
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